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Injury/Illness 
The Injury/Illness Manual explains how to use the Injury/Illness module to track injuries and illness for 
resources during an incident. 
  
Topics in this guide include the following: 
  

• Common Features (See Page 4) 

• Selecting Injury/Illness Options (See Page 8) 

• Adding an Injury/Illness (See Page 10) 

• Advanced Search (See Page 13) 

• Editing an Injury/Illness (See Page 15) 

• Deleting Injury/Illness (See Page 17) 

• View History (See Page 18) 

• Stats Base (See Page 20) 

• Injury/Illness Reports (See Page 22) 

• Creating an Injury/Illness Export File (See Page 30) 
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Common Features 
This section describes the menus and toolbars available in the Injury/Illness module. 

Menus 

The following drop-down menus display at the top of the I-Suite windows:  
  

File Menu 
The following options are available in the File menu in all modules: 
  

• Open Database - Opens an incident database in I-Suite. 

• Print - Prints the grid in the open module or a report selected on the Reports 
window. 

  

The Print option is not available in the Database Admin module. 

  

• Refresh Data - Refreshes the data on your window. 

• Exit - Closes the I-Suite application. 
  

Modules Menu 
The following options are available in the Modules menu: 
  

• Database Admin - Opens the Database Admin Module. 

• Data Admin - Opens the Data Admin Module. 

• Resources - Opens the Resources Module. 

• Cost - Opens the Cost Module. 

• Supply - Opens the Supply Module. 

• IAP - Opens the Incident Action Plan Module. 

• Demob - Opens the Demob Module. 

• Time - Opens the Time Module. 

• Injury/Illness - Opens the Injury/Illness Module. 
  

Filters Menu 
Select an option from the Filters drop-down menu to filter the Resources grid by:  
  

• Aircraft  

• Crews  

• Equipment  

• Overhead  

• All  
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• All Personnel  
  
  

Reports Menu 
Select an option from the Reports menu to print the following types of reports: 
  

• Cost Reports  

• Demob Reports  

• Plans Reports  

• Supply Reports  

• Time Reports  

• Custom Reports  

• Injury/Illness Reports 
  

Tools Menu 
The following options are available in the Tools menu in all modules: 
  

• Options - Define the settings for the different modules in I-Suite. 
  

The settings you can change in Options depends on the permissions that are assigned to you in the I-
Suite system. 

  

• Quick Stats - Quickly view Stats in the I-Suite system. 

• Change Password - Change your I-Suite password. 
  
  

Help Menu 
The following options are available in the Help menu: 
  

• I-Suite Help - Opens Help information for the I-Suite application. 

• About - Displays version information for I-Suite. 

• Support - Displays contact information for the HelpDesk. 
  

Toolbars 

The following toolbars display at the top of the I-Suite windows: 
  

Main Toolbar 
The Main toolbar contains two separate types of buttons: 
  

Module Buttons 
The Module buttons open modules in the I-Suite system. These buttons are located on the left side of 
the Main toolbar. The following example identifies the buttons and the modules that they open: 
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Action Buttons 
The Action buttons perform an action in one of the I-Suite modules. These buttons are located on the 
right side of the Main toolbar. The following example identifies the buttons and the action that occurs: 

  

 

Filter Toolbar 
The Filter toolbar displays beneath the Main toolbar. Click the buttons in this toolbar to filter the 
information in the Resources grid. The following example identifies the buttons in this toolbar and the 
resources that display in the grid when you click the buttons: 
  

 
  
  

  

Injury/Illness Toolbar 
The Injury/Illness toolbar displays to the right of the Filter toolbar when you are in the Injury/Illness 
module. The following example identifies the buttons in this toolbar. 
  

 
  

• Show Injury/Illness Details - Display the Manage Injury/Illness area. 
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• Defaults - Set defaults for the Injury/Illness module. 

• View History - View a history of injuries and illnesses. 

• Stats Base - Define statistics to use in the Injuries and Frequency report. 

• Previous Injury/Illness - Only display resources with previous injury or illness 
records in the grid. 
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Selecting Injury/Illness Options 

Follow the steps in this section to select the options to use in the Injury/Illness area of the I-Suite 
application: 
  

1. From the Tools drop-down menu, select Options to open the Options window. 

2. Click the Injury/Illness tab. 

You can also click the Defaults button on the Injury/Illness window to open the Options window with the 
Injury/Illness tab selected. 

  

 
  

3. Under Resource Grid Columns, hold down the Ctrl key and click to highlight 
each of the columns you want to select. 
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4. If you want to remove the selected columns from the Resource grid, click the 
Hide button. 
 
If you want to display the selected columns in the Resource grid, click the Show 
button 

Each column with a checkmark in the checkbox next to it is included in the grid. When you click the Show 
button, it places a checkmark in the checkbox next to the selected column. When you click the Hide 
button, it removes the checkmark from the checkbox. You can also click the checkbox next to a listed 
column to either Show or Hide it. 

  

5. To define a default Incident Type to display in the Incident Type box on the 
Injury/Illness window, select one of the following options from the Incident Type 
drop-down list: 

• All Hazard 

• Prescribed Fire 

• Wildland Fire 

• Wildland Fire Use 

6. To define a default Management Level to display in the Management Level box 
on the Injury/Illness window, select a level (1-5) from the Management Level 
drop-down list. 

7. To define a default Est. Hrs Worked / Day on the Stats Base window, enter the 
amount in the Estimated Average Hours worked per Day per Resource box. 

8. Click the Save button to save your changes. Click the OK button to close the 
Options window. 
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Adding an Injury/Illness 
Follow the steps in this section to add an injury, illness or prevention record: 
  

1. From the Modules drop-down menu, select the Injury/Illness option to open the 
Injury/Illness window. 

2. In the Resources grid, click the resource for which you are adding the injury, 
illness or prevention record. The Manage Injury/Illness - Add Mode area at the 
bottom of the window becomes active. 

 
  

The resource you select must be a person. You cannot create an injury, illness or prevention record for a 
non-person resource. 

  

3. Click the Injury, Illness or Prevention option to identify whether this is an injury, 
illness or prevention item. 

The labels on the window will change based on the option you select. For example, if you select Injury, 
the label Injury Date displays. If you select Illness, the label changes to Illness Date. 

  

4. If the injury or illness was pre-existing, click to check the Pre-Existing checkbox. 

5. In the Seen Date box, enter the date when the resource was initially seen for the 
condition. You can either type the date or select it from the drop-down calendar. 

6. In the Injury/Illness/Prevention Date box, enter the date when the injury or 
illness first occurred. If this is a prevention item, enter the date when the resource 
first needed the item. You can either type the date or select it from the drop-down 
calendar. 



  

     
    Chapter 4:Adding Injury/Illness

  

I-Suite Version 13.01.00 Injury/Illness 11 
  

7. In the Injury/Illness/Prevention Time box, enter the time when the injury or 
illness occurred. If this is a prevention item, enter the time when the resource 
needed the item. 

8. From the Location on Incident drop-down list, select where the resource was 
located when the injury or illness occurred. If this is a prevention item, select the 
resource's location when they needed the preventative item. 

9. From the Incident Type drop-down list, select the appropriate type of incident. 

If a default incident type was defined on the Options window, it will automatically display in the Incident 
Type box. If needed, you can change this entry by selecting another type from the drop-down list. 

  

9. From the Incident Management Level drop-down list, select the appropriate 
management level.  

If a default management level was defined on the Options window, it will automatically display in the 
Incident Management Level box. If needed, you can change this entry by selecting another level from 
the drop-down list. 

  

10. From the Incident Phase drop-down list, select the appropriate phase. 

11. From the Incident Where Injury/Illness/Prevention Occurred drop-down list, 
select the incident where the resource was working when the injury or illness 
occurred. If this is a prevention item, select the incident where the item is needed. 

The entry in the Incident Where Injury/Illness/Prevention Occurred box automatically defaults to the 
incident where the resource is assigned. 

  

12. From the Injury/Illness Type drop-down list, select the appropriate injury or 
illness. 

When Prevention is selected, the Injury/Illness Type box does not display on the window. Enter any 
applicable information about the Prevention in the Remarks area. 

  

13. From the Activity at Time of Injury/Illness/Prevention drop-down list, select the 
activity the resource was performing when the injury illness occurred. If this is a 
prevention item, select the activity for which the item is needed. 

14. From the Section Assignment drop-down list, select the appropriate section 
assignment. 

15. From the Sub Assignment drop-down list, select the appropriate sub-assignment. 

The options available in the Sub Assignment drop-down list are based on the Section Assignment that 
is selected. 

  

16. In the Division/Group Name box, type the appropriate division or group name. 
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17. If there was restricted duty or lost time because of the illness or injury, click to 
check the Restricted Duty/Lost Time checkbox. 

18. If the resource was seen off-site for the injury or illness, click to check the 
Treatment Off-Site checkbox. 

19. In the Remarks box, enter any additional information about the injury or illness. 
Use this area to identify any known or suspected factors that contributed to or 
caused the injury or illness. If this is a prevention item, type a description of the 
item and any other applicable information in the Remarks area. 

If your remarks will not fit in the Remarks box, click the Remarks button to display a Remarks window 
where you can enter additional remarks. 

  

20. Click the Save button to save the injury, illness or prevention record. Notice that 
the saved record displays in the grid at the bottom of the window.  

21. When the Data Saved window displays, click the OK button to close the window. 
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Advanced Search 
Follow the steps in this section to perform an advanced search for an Injury or Illness Type: 
  

1. In the Manage Injury Illness area, click the Search button that displays next to the 
Injury/Illness Type box to open the Injury/Illness Search window. 

 
  

2. In the Search For box, type the name of the injury or illness that you want to find. 

3. Click the Search button to limit the grid to only list those items with a search term. 
(e.g. If you enter "Burn," only those items with burn in the name display in the 
grid.) 

4. In the grid at the top of the window, click the appropriate type. 

5. Click the OK button to close the Injury/Illness Search window and insert the 
highlighted type into the Injury/Illness Type box. 
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You can also double click a type in the grid to close the Injury/Illness Search window and insert the type 
into the Injury/Illness Type box. 
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Editing an Injury/Illness 
Follow the steps in this section to edit an injury, illness or prevention record: 
  

1. From the Modules drop-down menu, select the Injury/Illness option. 

2. In the Resources grid, click the appropriate resource. 

3. In the Injury/Illness/Prevention grid at the bottom of the window, click the record 
you want to edit. The record's information displays under Manage Injury/Illness - 
Edit Mode. 

  

 
4. Make the appropriate changes to the injury/illness or prevention information. 

If you change the Injury, Illness or Prevention selection, the entry in the Injury/Illness Type box is 
removed. You must select a new Injury/Illness type from the Injury/Illness Type drop-down list. If you do 
not select a new type, an error message will display indicating that you must define an Injury/Illness 
Type before saving the record. 

  

5. Click the Save button to save the changes. 
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The record you are editing remains selected until you select another injury, illness or prevention record or 
select another resource. 

  

To add a new injury, illness or prevention record, click the Add button at the bottom of the window. 
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Deleting Injury/Illness 
Follow the steps in this section to delete Injury/Illness records: 
  

1. From the Modules drop-down menu, select the Injury/Illness option. 

2. In the Resources grid, click the appropriate resource. 

3. In the Injury/Illness/Prevention grid at the bottom of the window, click the record 
you want to delete. 

4. Click the Delete button at the bottom of the window. A confirmation window 
displays 

 
  

5. Click the Yes button to remove the injury, illness or prevention record. 
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View History 
Follow the steps in this section to view a history of injury/illness records: 
  

1. From the Modules drop-down menu, select the Injury/Illness option. 

2. Click the View History button in the Injury/Illness toolbar to open the history 
window. 

 
  

3. Click the Resource button to sort the grid based on resources with injury, illness 
or prevention records.  

When Managing Incidents Separately, the grid only includes those resources assigned to the selected 
incident. If a resource was assigned to the selected incident, but received the injury/illness/prevention 
while working on a different incident, the name of the incident on which they were working displays in the 
Occurred Incident column. 
 
When Manage All Incidents as One is selected, an Assigned Incident column displays in the grid. This 
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column identifies the incident to which the resource was assigned. The Occurred Incident column 
identifies the incident on which they were working when the injury/illness/prevention occurred. 

  

4. Click the Injury/Illness/Prevention button to sort the grid based on injury, illness 
and prevention records. 

When Managing Incidents Separately, the grid only includes those injures and illnesses that occurred 
for the selected incident. When you click the plus sign (+) next to an Injury/Illness/Prevention record, a list 
of resources for which the records were created displays. The Assigned Incident column identifies the 
incident to which the resource was assigned. 
 
When Manage All Incidents as One is selected and you click the plus sign (+) next to an 
Injury/Illness/Prevention record, an Occurred Incident column displays. This column identifies where the 
resource was working when the injury/illness/prevention occurred. 

  

5. Click the Close button when you have finished viewing the history. 
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Stats Base 
Follow the steps in this section to define the Stats Base to use with Injuries and Frequency Report: 
  

To Add or Edit Stats Base data, a Single Incident must be selected. You cannot Add or Edit Stats 
Base data when in Manage All Incidents as One mode. 

  

1. From the Modules drop-down menu, select the Injury/Illness option. 

2. Click the Stats Base button in the Injury/Illness toolbar to open the Stats Base 
window. 

If the Manage All Incidents as One checkbox is checked, a message displays indicating that you cannot 
Add or Edit Stats Base Data when Manage All Incidents As One is selected. If you click Yes to continue, 
the Stats Base window opens in View Only mode.  

  

 
  

3. In the Date box, enter the appropriate date for the statistics. You can either type 
the date or select it from the drop-down calendar. 
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4. In the Total People box, type the total number of people working on the specified 
date. 

5. In the Est. Hrs Worked / Day box, type the average number of hours each person 
worked that day. 

If a default Estimated Average Hours Worked per Day per Resource was defined on the Options 
window, that amount displays in the Est. Hrs Worked / Day box. If needed, you can change this amount 
by typing over the amount. 

  

6. Click the Save button. 

7. When the Data Saved window displays, click the OK button to close the window. 

  

When you save the statistics, I-Suite automatically calculates the cumulative work hours for that day. The 
statistics display in the grid at the top of the window 
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Injury/Illness Reports 
Follow the steps in this section to print Injury/Illness Reports: 
  

1. From the Modules drop-down menu, select the Injury/Illness option to open the 
Injury/Illness module. 

2. In the Main toolbar, click the Reports button to open the Injury/Illness Reports 
window. 

3. In the Reports frame, click to select one of the following reports: 

• Injury/Illness by Type (See Injury/Illness by Type on Page 22) 

• Injury/Illness Prevention (See Injury/Illness/Prevention on Page 23) 

• Injury/Illness by Date (See Injury/Illness by Date on Page 24) 

• Injuries and Frequency (See Injuries and Frequency on Page 25) 

• Medical Unit Daily Summary  (See Medical Unit Daily Summary on Page 26) 

• Injury/Illness Types (See Injury/Illness Types Report on Page 26) 

  

Injury/Illness by Type 

This report identifies the total number of injuries, illnesses and preventions currently defined in I-Suite. 
The information is broken down by injury/illness type.  
  
To generate an Injury/Illness by Type report, complete the following steps: 
  

1. On the Injury/Illness Reports window, click Injury/Illness by Type to display the 
Report Settings: 
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2. Click one of the following options to identify the dates to include in the report: 

• All Dates - Includes all dates in the report. 

• Date Range - Includes the date range defined in the Date Range boxes. 
When you select this option, you must enter dates into the two boxes 

3. To preview and then print the report, click the Preview button. When the Preview 
window opens, click the Print Report button. 
 
To print the report without first previewing it, click the Print button. 

4. When the Print window displays, click the Print button. 

  

Injury/Illness/Prevention 

This report includes detailed information about injury, illness or prevention records. 
  

The Injury/Illness/Prevention report does not include resource names. It only identifies the injury, illness 
or prevention information. 

  
To generate an Injury/Illness/Prevention report, complete the following steps: 
  

1. On the Injury/Illness Reports window, click the Injury/Illness Prevention option to 
display the Report Settings. 

 
  

2. Under Sort, double click each sort to use in the report. The Sort moves from the 
left frame to the right frame. The sort order in the report is based on the order in 
which you select the sort options. 

3. Under Event Category, click one of the following options to identify the 
information to include in the report: 

• Injury - Only includes Injury records in the report. 
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• Illness - Only includes Illness records in the report. 

• Prevention - Only includes Prevention records in the report. 

• All - Includes Injury, Illness and Prevention records in the report. 

4. To preview and then print the report, click the Preview button. When the Preview 
window opens, click the Print Report button. 
 
To print the report without first previewing it, click the Print button. 

5. When the Print window opens, click the Print button. 

  

Injury/Illness by Date 

This report identifies the total number of injuries, illnesses and preventions that occurred on a defined 
date. 
  
To generate an Injury/Illness by Date report, complete the following steps: 
  

1. On the Injury/Illness Report window, click the Injury/Illness by Date option to 
open the Report Settings. 

 
  

2. Click one of the following options to identify the dates to include in the report: 

• All Dates - Includes all dates in the report. 

• Date Range - Includes the dates defined in the Date Range boxes. When you 
select this option, you must enter dates into the two boxes. 

3. To preview and then print the report, click the Preview button. When the Preview 
window opens, click the Print Report button. 
 
To print the report without first previewing it, click the Print button. 

4. When the Print window opens, click the Print button. 
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Injuries and Frequency 

This report identifies the number of people injured as compared to the number of people working and the 
hours worked on a defined date. It also identifies the cumulative injuries and frequency of injuries. 
  

The Injuries and Frequency report uses the statistics defined in the Stats Base to generate the data for 
this report. 

  
To generate an Injuries and Frequency report, complete the following steps: 
  

1. On the Injury/Illness Report window, click the Injuries and Frequency option to 
display the Report Settings. 

 
  

2. Click one of the following options to identify the dates to include in the report: 

• All Dates - Includes all dates in the report. 

• Date Range - Includes the dates defined in the Date Range boxes. When you 
select this option, you must enter dates into the two boxes. 

3. Under Frequency Formula, click one of the following options to identify the 
formula to use in calculating the data for the report: 

• OSHA (# injury/illnesses X 200,000) / (# of hours worked) 

• BASIC (# injury/illnesses) / (# of hours worked) 

4. To preview and then print the report, click the Preview button. When the Preview 
window opens, click the Print Report button. 
 
To print the report without first previewing it, click the Print button. 

5. When the Print window displays, click the Print button. 
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Medical Unit Daily Summary 

This report contains a summary of injuries and illnesses that were reported to the Medical Unit for each 
defined date. 
  
To generate a Medical Unit Daily Summary, complete the following steps: 
  

1. On the Injury/Illness Report window, click the Medical Unit Daily Summary  
option to display the Report Settings. 

 
  

2. Click one of the following options to identify the dates to include in the report: 

• All Dates - Includes all dates in the report. 

• Date Range - Includes the dates defined in the Date Range boxes. When you 
select this option, you must enter dates into the two boxes. 

3. To preview and then print the report, click the Preview button. When the Preview 
window opens, click the Print Report button. 
 
To print the report without first previewing it, click the Print button. 

4. When the Print window opens, click the Print button. 

  

Injury/Illness Types Report 

This report contains a list of all Injury/Illness Types the medical or safety officer can select from the 
Injury/Illness Type drop-down list. 
  
To generate the Injury/Illness Types Report, complete the following steps: 
  

1. On the Injury/Illness Reports window, click the Injury/Illness Types option. 

2. To preview and then print the report, click the Preview button. When the Preview 
window opens, click the Print Report button. 
 
To print the report without first previewing it, click the Print button. 

3. When the Print window opens, click the Print button. 
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Injury/Illness Report Descriptions 
The following Injury/Illness reports are available in I-Suite: 
  

Injury/Illness by Type 

This report identifies the total number of injuries, illnesses and preventions currently defined in I-Suite. 
The information is broken down by injury/illness type for each date. 
  

Injury/Illness/Prevention 

This report includes detailed information about injury, illness or prevention records. 
  

The Injury/Illness/Prevention report does not include resource names. It only identifies the injury,illness 
or prevention information. 

  
This report includes the following information: 
  

• Event Date/Time 

• Date Seen 

• Section Assignment 

• Remarks 

• Event Category 

• Activity at Time of Injury 

• Event Type 

• Incident Type 

• Sub-Assignment 

• Restricted/Lost Time 

• Location at Incident 

• Management Level 

• Division/Group 

• Incident Number 

• Incident Phase 
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• Incident Name 

• Treatment Offsite 

  

Injury/Illness by Date 

This report identifies the total number of injuries, illnesses and preventions that occurred on a defined 
date. 
  

Injuries and Frequency 

This report identifies the number of people injured as compared to the number of people working and the 
hours worked on a defined date. It also identifies the cumulative injuries and frequency of injuries. 
  

The Injuries and Frequency report uses the statistics defined in the Stats Base to generate the data for 
this report. 

  
Depending on the option selected on the Injury/Illness Reports window, the Frequency formula is based 
on either OSHA (# injury/illnesses X 200,000) / (# of hours worked) or BASIC (# injury/illnesses) / (# of 
hours worked) 
  
The information in this report includes: 
  

• Seen Date 

• Total Personnel 

• Hours Per Person/Per Day 

• Hours Worked 

• Cumulative Hours Worked 

• Injuries by Date 

• Injury Frequency by Date 

• Cumulative Injuries 

• Injury Frequency Cumulative 

• Lost Time for Injuries by Date 

• Lost Time for Injuries Frequency by Date 

• Cumulative Lost Time for Injuries 

• Lost Time for Injuries Frequency Cumulative 

  

Medical Unit Daily Summary 

This report identifies injury and illness issues that were reported to the Medical Unit at an incident for 
each defined date. 
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The information in this report includes: 
  

• Incident where Injury/Illness/Prevention Occurred 

• Date Seen 

• Resource Position 

• Unit/Crew 

• Government or Non-Government 

• Nature of Injury/Illness 

• Remarks 

  

Injury/Illness Types 

This report identifies injury and illness types medical or safety officers can select from the Injury/Illness 
Type drop-down list. The information in this report includes: 
  

• Injury/Illness Type 

• Abbreviated Type 

• Nature Code 
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Exporting I-Suite Data Files 
This section explains how to create and then export Injury/Illness  data files to the Data Repository.  
  
You must have a DMS User Name and Password to access the repository site. Contact your Incident 
Commander or the I-Suite Help Desk for more information. 
  

Creating an Injury/Illness Export File 

Follow the steps in this section to create an Injury/Illness Export file: 
  

1. From the Modules drop-down menu, select the Database Admin option to open 
the Database Admin window. 

2. Click the Export Data button to open the Data Export window: 
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3. Click the Injury/Illness option under Export Type. 

4. From the DataBase drop-down list, select the database for which you are creating 
the export file. 

5. From the Incident drop-down list, select the incident for which you are creating 
the export file. 

6. Click the OK button to create the export file. 

7. When the export is complete, the Data Export window redisplays with the 
exported file listed in the Data Export History frame. Click the Close button on 
the Data Export window to close the window. 

The file is exported to C:\Program Files\ISuite\Data_Export\Injury 

  

Uploading the Data Repository File  

Follow the steps in this section to upload a data file after you create it: 
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1. Start your Internet browser. 

2. In the Address box, type isuite.nwcg.gov to open the I-Suite Web page. 

3. On the Welcome to I-Suite web page, click the Data Repository option. 

4. When the Security Alert window displays, click the Yes button to continue with 
the upload process. A Connect to isuite.nwcg.gov window displays. 
 

 

5. Enter your DMS User Name and DMS Password. Then click the OK button. The 
I-Suite Upload Form page displays.  
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6. Click the Browse button next to the File field. Use the window that displays to 
locate and select the appropriate data repository file.  

The default folder location for saving repository files is C:\Program 
Files\ISuite\Data_Export\Repository. 

  

8. Click the Upload button. When the data repository files have finished uploading, 
the ISUITE Upload Results screen displays.  
 

 

9. Click the Back button on your Internet browser to upload additional data 
repository files, or close your browser, as appropriate. 
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Revision History 
Revision Date Revision Summary 
2010-04-27 Revised instructions for the 10.01.00 version of I-Suite. 
2009-05-01 Revised instructions for the 9.01.00 version of I-Suite. 
2008-04-25 Revised instructions for the 8.01.00 version of I-Suite. 
2007-07-25 Revised instructions for the 7.01.05 version of I-Suite. 
2007-04-20 Added information for new Injury/Illness module. 
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